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Overview of Corticon Installations

This guide presents procedures for accessing, downloading, and running Corticon 5.7 installers, as well as
providing dynamic access to information about supported platforms. Links to the Progress Corticon
KnowledgeBase provide additional information about third-party software setup.
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Preparing for a Corticon Installation

Before running installers

To avoid possible constraints on the installer, do the following:

* Confirm that you have Administrator permissions on the target machine - Administrator rights allow
the installer to copy all the Corticon files to their proper locations. You must have Administrator rights and
permissions to install this software. See your system administrator to obtain these rights.

* Obtain system access - Several Corticon features write files to the “home” directory structure. If the target
machine for the Corticon installation does not have read and write access to this directory, you need to
choose a directory location where Corticon will have both read and write access.

* Disable anti-virus, anti-malware, and anti-spyware protection applications - Before performing the
installation, consider temporarily disabling any anti-virus and anti-spyware software that may be running on
the target machine, as such software might interfere with correct installation.

For details, see the following topics:

* Evaluation licensing

* System requirements

* About Corticon upgrades

* Downloading Corticon installer packages

* Applying a Service Pack or Hotfix
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Chapter 2: Preparing for a Corticon Installation

Evaluation licensing

Progress Corticon products are licensed for evaluation immediately after installation.

Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development of business
rules projects, as well as testing of the projects in an embedded test server. You must obtain Studio development
licenses from your Progress representative.

Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule modeling projects
on supported platform configurations. You must obtain server deployment licenses from your Progress
representative. See Limits of the Server evaluation license on page 31 to determine whether the evaluation
license will constrain your evaluation.

System requirements

Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio

Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix to review the
currently supported Corticon Studio operating systems, and Eclipse versions.

The target system for a Corticon Studio installation requires:
* Supported Windows operating system

* 8 GB System RAM (minimum of 2 GB available RAM)

* 650 MB disk space

*  When an existing Eclipse will be used, a supported Eclipse version

Corticon Server for Java

Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix to review the
currently supported platforms and application servers. Also see the Corticon KnowledgeBase entry Corticon
Server 5.X sample EAR/WAR installation for different Application Servers for detailed instructions on configuring
Apache Tomcat, JBoss, WebSphere, WebLogic on all supported platforms.

The target system for a Corticon Server for Java installation requires:

* Supported Windows or Linux operating system

* When deploying on other platforms, a supported operating system and application server
* 8 GB System RAM (minimum of 2 GB available RAM)

* 600 MB disk space

Corticon Server for .NET

Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for information
on supported .NET Framework and IS versions, and the Corticon Knowledgebase article appropriate for your
target 11S/platform, as listed in the topic Setting up and updating 1IS for .NET Server on page 28.

The target system for a Corticon Server for .NET installation requires:
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About Corticon upgrades

¢ Supported Windows operating system

* Supported .NET Framework and Internet Information Service (IIS)
* 8 GB System RAM (minimum of 2 GB available RAM)

* 500 MB disk space

Corticon Web Console

Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for information
on supported browser versions.

The target system for a Corticon Web Console installation requires:
* Supported Windows or Linux operating system

* 4 GB System RAM (minimum of 2 GB available RAM)

¢ Java option for MaxPermSize set to at least 256m

* 600 MB disk space

Note: When all three Server components are installed on one machine, the required space for the installation
is about 1 GB.

About Corticon upgrades

Upgrading from an earlier release

Existing Corticon users advancing to this release will want to know whether their existing products can co-exist
with the newer version, as well as any strategies for perpetuating the assets created in their current version.

If you have an existing installation of Corticon products on the target machine, do the following:

* For an upgrade of a 5.3.x, 5.4.x, 5.5.x, or 5.6.x installation to 5.7 - If you are upgrading from 5.3, 5.4,
5.5, or 5.6 installed software on the same machine, 5.7 will install to new location and run independent of
the other releases. You must manage any port overloads that might result from running both versions.

* For an upgrade of a 5.2 or earlier version 5 installation to 5.7 - An installed version of Corticon 5.2 or
earlier installed on the target machine must be uninstalled, then the appropriate Corticon 5.7 product installed.

We recommend that you consult with Progress Corticon Support or your Progress representative to discuss
your migration strategies for existing assets before you take action.

* Foran upgrade of a 4.3 or earlier installation to 5.7 - Download and install Corticon Studio 5.3.0 or 5.4.0,
and then perform the procedures in its Corticon Migration Guide. Once completed, uninstall the 4.3 installation,
and install 5.7 where its upgrade utility can bring project assets up to date. We recommend that you consult
with Progress Corticon Support or your Progress representative to discuss your migration strategies for
existing assets before you take action.

Downloading Corticon installer packages

To download required Corticon installers:
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1. Get credentials to access and download packages on the Progress Software Electronic Software Download
(ESD) site.

2. Connect to the ESD, and then navigate to the Corticon 5.7 page.

3. Locate, download, and save the required installers to a temporary location accessible by the target machine.

Downloading the Corticon Studio installer package
For supported Windows machines: PROGRESS CORTICON 5.7 STUDIO WIN 64.exe

Downloading the Corticon Server and Web Console packages
Microsoft Windows

Corticon Server and Web Console 5.7 products for Windows -- Java Server, .NET Server, and Web Console
-- are packaged in executable installer applications and ZIP archives.

For supported Windows machines, download: PROGRESS CORTICON 5.7 SERVER WIN 64.exe
Zip Archives

Corticon Server and Web Console .war files are available in a Corticon Server .zip archive. Use it to install the
Server Console or Web Console on a supported application server without using the executable installers.

Linux

Corticon Server and Web Console 5.7 products for Linux -- Java Server, and Web Console — are packaged in
executable installer applications for supported Linux machines:
PROGRESS CORTICON 5.7 SERVER LNX 64.bin

Applying a Service Pack or Hotfix

Install Corticon Service Packs and Hotfixes with new installations of Corticon when necessary, or to upgrade
an existing installation. To apply a service pack or hotfix, navigate to the Progress Software Electronic Software
Distribution (ESD) download web site for Corticon products, and locate the appropriate package. Then, install
it on your target machine.
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Installing Corticon Studio

There are several techniques for installing Corticon Studio:

Running the Corticon Studio installer wizard on page 14, the typical use, which enables a complete Corticon
Studio Eclipse installation that can standalone, or be tailored into another Eclipse IDE on the same machine.

Performing Silent Installations of Studio on page 17 that generates a file from an installer wizard run to let
you perform silent Studio installations on other machines.

Installing Corticon Studio plugins into an existing Eclipse on page 18 which enables scripted installation of
Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide

The installer wizard package includes:

Corticon Studio resources

Eclipse Development Environment and Eclipse online documentation.
Java Runtime Environment (JRE)

Sample projects

API documentation for extending Corticon

Corticon Server runtime for use in testing rules you create in Corticon Studio

Progress Corticon: Installation Guide: Version 5.7
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Chapter 3: Installing Corticon Studio

Installation options

A new Corticon Studio install lets you choose to install it standalone, or to add its plugins to an existing Eclipse
4.5 installation.

For details, see the following topics:

Running the Corticon Studio installer wizard

Performing Silent Installations of Studio

Installing Corticon Studio plugins into an existing Eclipse
Increasing Corticon Studio memory allocation

Setting Studio to run in another language

Running the Corticon Studio installer wizard

The Studio installer will install or update Studio 5.7.

Installing or updating Studio 5.7

To perform a new installation of Corticon Studio 5.7:

1.

Double click on the installer file, PROGRESS CORTICON 5.7 STUDIO WIN 64.exe, tolaunch the Corticon

Studio installer.

The installer opens in the installer wizard.

The first installer panel opens with information about the installer.

Progress Corticon Studio 5.7.0.0

Corticon Studio.

cantinuing with this installation.

hutton.

?n PFDQFESS' InstallAnywhere will guide you thraugh the installation of Progress
Itis strongly recommended that you quit all programs before
Progress® Corticon® Click the 'Nest' button to proceed to the nest screen. [Fyou want to

change something on a previous screen, click the 'Previaus' button.

You may cancel this installation at any time by clicking the '‘Cancel’

=10 x|

Introduction

Previous

3. Click Next to continue.

14
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Running the Corticon Studio installer wizard

The License Agreement panel opens.
Progress Corticon Studio 5.7.0.0 = ﬂ
License Agreement

:n PTOQFESS“ Installation and Use of Progress Corticon Studio Requires
Acceptance of the Following License Agreement:

End User License Asreement

gress* Corficon®

CAUTION: YOU SHOULD CAFREFULLY READ THE FOLLOWING
TEFMS AND CONDITIONS OF THIS end user license AGREEMENT
BEFORE INSTALLING OR USING THE PRODUCT AND
DOCUMENTATION TO WHICH THIS AGREEMENT ERELATES. BY
ACCEPTING THIS AGEEEMENT YOU ARE CONSENTING TO EE
BOUND BY THE TEFMS AND CONDITIONS CONTAINED
HEREIN AND ACKENOWLEDGING YOUR AUTHORITY TO DO 30 ON
BEHALF OF YOUR COMPANY (IF AFFLICABLE). IF YOU DO NOT
AGREE WITH THESE TERMSE AND CONDITIONS, DO NOT PROCEED ~

G i accept the terms of the License Agresment

i i | do NOT acoept the terms of the Licenss Agresment

Cancel

This panel displays the Progress Software End User License Agreement (EULA). Use the scroll bar at the
right of the screen to read the agreement content.

4. When you understand and agree to the terms, choose | accept the terms in the license agreement, and
then click Next to continue.

The Choose Install Folder panel opens.

E Progress Corticon Studio 5.7.0.0 = ﬂ
Progress Corticon Studio Install and Work directory
3) Progress’

Please choose Install and Work Directory

Install Directory |C:\Program Files'\ProgressiCorticon 5.7

l Restore Default ” Choose..

Work Directory | C:\Users\gsaintma\Progress\CorticonWork_5.7

l Restore Default ” Choose...

Cancel Frevious
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Chapter 3: Installing Corticon Studio

5. Specify the installation location. The default location for the installation directory and the work directory are
as shown above. (For the work directory, the default subdirectory under Users is the current username.)
Either accept the default locations, or specify each preferred (and different) location.

6. Click Next.
7. The External eclipse configuration panel opens:

E Progress Corticon Studio 5.7.0.0 = &

External eclipse configuration

3) Progress’

Do you want to configure Corticon Studio with external eclipse?

Progress® Corticon®

* If you select Yes on this panel, the entry area for the External Eclipse location in which you want to
add Corticon Studio (in addition to a standard installation) is presented:

E Progress Corticon Studio 5.7.0.0 = ﬂ

External eclipse configuration
3) Progress’

Do you want to configure Corticon Studio with external eclipse?

Progress® Corticon®

© ¥es
External eclipse location

Restore Default ” Choose...
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Performing Silent Installations of Studio

Enter or browse to the location of the existing Eclipse 4.5 64-bit installation.
* If you leave the selection as No, a normal installation will proceed.

When you have decided which path to take, click Next to continue.

8. The Pre-installation Summary panel opens.

Progress Corticon Studio 5.7.0.0 Ll_lﬁ

Pre-Installation Summary

m PFOQFESS' Please Review the Following Before Continuing:

Product Name:
Progress Corticon Studio

Progress® Corticon® Install Folder:
C\Program Files\Progress\Corticon 5.7

Work Directory:
C\Users\gsaintma\Progress\CorticonWork 5.7

Disk Space Information (for Installation Target):
Required: 507,743,115 Bytes
Available: 119,891,152.896 Bytes

Cancel Previous

Confirm that your installation location has adequate disk space for the Corticon Studio components as well
as at least 100 MB of workspace.

9. Click Install to continue.

An installation status window opens to display the state of the installation process. When the process has
finished, the Install Complete panel opens.

10. Click Done to quit and close the installer.

The installation or update of Corticon Studio 5.7 is complete.

Performing Silent Installations of Studio

An unattended (silent) install requires that you first run an installation or updater in the installer wizard to capture
the selected options, and then use the captured response file on other targets to 'playback’ the responses into
the installer without any user interaction.

To perform silent installations for Corticon Studio:

1. Run the Studio installer with your preferred locations and options to capture a response file, using the syntax
installer.exe -r filewhere installeris the preferred Studio installer, and r£ile is the response
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Chapter 3: Installing Corticon Studio

file you will reuse. For example, PROGRESS CORTICON 5.7 STUDIO WIN 64.exe -r
C:\CorticonStudio64 57.responses

2. On other target machines, access the Studio 5.7 installer executable and the response file.

3. On those machines, run the installer using the syntax installer.exe -i silent -f file where
installer is the Studio installer, and file is your response file. For example,
PROGRESS CORTICON 5.7 STUDIO WIN 64.exe -i silent -f
C:\CorticonStudio64 57.responses.

Installing Corticon Studio plugins into an existing
Eclipse

These instructions apply when you want to install Corticon functionality into an installed 64-bit Eclipse IDE.

1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime Environment
(JRE). If you do not have one installed locally, download and install a 1.7 or higher 64-bit version from the
Oracle Java website http://www.oracle.com/technetwork/java

Note: For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is using. In
Eclipse, choose Window > Preferences, then select Java > Installed JREs.

2. Download and perform a standard installation of Corticon Studio into a clean directory on the target machine.
This installation will provide the script and the required files for the integration into your target Eclipse
location.

3. Ina Command Prompt window at the Corticon Studio's [CORTICON HOME] /Studio location, check to
see whether JAVA HOME is set. If not, set JAVA HOME to the JDK root. For example: set
JAVA HOME=c:\jdkl.7u67_64

4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.

5. In the Command Prompt, run the integration script in the form:

integrateCorticon.bat -install eclipse target

where eclipse_target is the root directory of the target Eclipse installation.

Eclipse installs its required plug-ins.

6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK to your PATH
as the default Java to use. For example:

set PATH=%JAVA HOME$%\bin; $PATHS

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other temporary
files. For example:

set CORTICON WORK DIR=c:\corticon work dir

18
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Increasing Corticon Studio memory allocation

8. When the script successfully completes, restart the Eclipse session, and then verify the installation by
selecting the menu command Help > About Eclipse. Click Installation Details to confirm that Progress
Corticon Feature is installed.

9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is being accessed
correctly.

The integrateCorticon script enables other functions:

COMMAND SYNTAX AND OTHER OPTIONS

Usage: integrateCorticon [OPTION] [TARGET ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install

-install Install Corticon plugins in TARGET ECLIPSE
-uninstall Uninstall Corticon plugins from TARGET ECLIPSE
-update Update Corticon plugins in TARGET ECLIPSE
-updateParams Update Corticon plugins parameters in TARGET ECLIPSE
-help Display this message

Increasing Corticon Studio memory allocation

When working on large Rule Projects, you will get better performance by increasing the amount of memory
available to Corticon Studio.

To change Corticon Studio memory allocation after installation, do the following:
1. Edit the command file eclipse.ini located at [CORTICON HOME]\Studio\eclipse

2. Change (typically, increase) the xmx value (maximum memory setting). The default xmx setting is 2 gigabytes,
specified as Xxmx2g.

Setting Studio to run in another language

You can specify a preferred language for Corticon Studio. the options are:

* English (en - default)

* French (fr)

* Japanese (ja)

* Portuguese (Brazilian) (pt BR)

* Spanish (es)

To set Corticon Studio to start in your preferred language:

1. Right-click on the Start menu item for Corticon 5.7 Studio, and then choose Properties.

2. In the properties dialog box, add the language option, -n1 followed by the language value, as shown in this
example setting ja for Japanese:
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Chapter 3: Installing Corticon Studio

ﬂ Corticon 5.7 Studio Properties

Security | Detail= I Previous Versions
General Shotet | Compatibilty
ga Corticon 5.7 Studio
Target type: Application

Target location: eclipse

Target: I-T-"x‘hc:meRStudin::‘»Studin\eclipse‘«ﬂclipse.exﬂ Tl ja

Start in: IC:\_E?X‘dmme‘\,Studin‘wstudiu"-ﬂcIipse

Shortcut key: INDne

X|

Run: INun‘naI window ﬂ
Comment I.Japanese
Open File Location | Change lcon... | Advanced... |
ok | Cancel | mppy |

3. Click Apply, and then OK to set the change.

When you start Corticon Studio its labels are in Japanese, as illustrated:

{71 Corticon Designer - ADC Database Connectivity/Medical.ecore - Progress Developer Studio

IFAIAR EBEE FES-—RN BEW | JOTzoRP)| EEV) ETR D02 FO0W) ALTH)
T | | i | SOz o ERELE b
: : h Oz o EREDSE

BFE. L D M e Cirl+B

Bg|e ¢ | 2& FOBT 5 ORI RE)

m ADC Database Connectivity D—%=4 7w RO EW) »

m Batch Rule Processing A1) — (N,

m EDC Database Connectivity v BB L )

m Multiple Database Connectivity

=

BF LT3 PAD S —SEFTTOA(L).
723 — FAMY 90— F(D)..

4o L—ILTF Y FEF v I L— F(U)..

Y ETLO—F - I AE— T OERE)

FO)Fr(P)

Progress Corticon: Installation Guide: Version 5.7



4

Installing Corticon Servers and Web Console

This section provides information about the installation procedures for the deployment and administration
components of Corticon Server as well as the Progress Application Server (PAS) -- a Web application server
based on Apache Tomcat -- that is used by the Java Server and the Web Console.

Note: Linux Installation - When you download and run the Linux server installer, you get shell (. sh) scripts
for start/stop and utility tools that correspond to the batch (.bat) scripts in a Windows installation.

There are several techniques for installing Corticon Server components:

* Running the Server and Web Console installer wizard on page 22, the typical use, which enables a complete
Corticon Server for Java, Corticon Server for .NET, and Corticon Web Console.

* Performing silent installations of Server components on page 26 that generates a file from an installer wizard
run to let you perform silent installations of Server components on other Windows machines.

¢ Performing command-line Linux installations of Server components on page 27 enables the Linux installer
to run from the shell as a command with parameters.

* Performing a manual installation of Server components: Corticon Server for Java and Web Console
are available in zip archives. Use them to manually install Corticon WAR/EAR files into a supported application
server on any supported platform. For details about installing Corticon into specific application servers, see
Corticon Server 5.X sample EAR/WAR installation for different Application Servers .

Considerations for Authentication

Confirm that servers that will host Corticon Server installations are enabled for authentication, and that Decision
Service administrators have the credentials to deploy to those servers.

Progress Corticon: Installation Guide: Version 5.7
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When you run the Corticon Server installer, the Progress Application Server (PAS) does not enable authentication
by default. To do so, see "Setting up authentication for secure server access" in the Integration and Deployment
Guide.

For details, see the following topics:

* Running the Server and Web Console installer wizard
* Performing silent installations of Server components
* Performing command-line Linux installations of Server components

¢ Setting up and updating IIS for .NET Server

Running the Server and Web Console installer wizard

The Server installer will install or update Servers and Web Console to 5.7.

Installing or updating Server and Web Console 5.7

You can install Corticon Servers and the Web Console on a machine that does or does not already have a
previous version installed. If a previous version is installed, you must manage any port overloads that might
result from running both versions.

Note: An installed version of Corticon Server 5.2 or earlier on the target machine must be uninstalled, then
Corticon Server 5.7 installed. Consult with Progress Corticon Support or your Progress representative to
consider your migration strategies for existing assets before you take action.

Installation procedure

If you have already installed either of the 5.7 Servers or the Web Console, the installer will allow you to install
components not previously installed, as well as update all installed components to the latest Service Pack.

To create or update an installation of Corticon Servers (Java and .NET) and Web Console 5.7:
1. On the target machine, access the Corticon 5.7 installers you downloaded.
2. To open the Progress Corticon Server Setup Wizard:

* For Windows, double click on: PROGRESS CORTICON 5.7 SERVER WIN 64.exe

* ForLinux, run: PROGRESS CORTICON 5.7 SERVER LNX 64.bin

The installer opens in the installer wizard. The first installer panel opens with information about the installer.
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Running the Server and Web Console installer wizard

Progress Corticon Server 5.7.0.0 - ﬂ

Introduction

:n PTOQFESS“ InstallAnywhere will guide you through the installation of Progress
Caricon Saerver.

tis strongly recommended that yvou quit all programs befare
continuing with this installation.

Click the 'Mext' button to proceed to the next screen. IFyou want to
change something on a previous screen, click the 'Previous' button.

You may cancel this installation at any time by clicking the 'Cancel’
huttan.

Cancel Previous

3. Click Next to continue.

The License Agreement panel opens.

E Progress Corticon Server 5.7.0.0 = ﬂ

License Agreement

:n PFOQFESS' Installation and Use of Progress Corticon Server Requires
Acceptance of the Following License Agreement:

End User License Apreement

CAUTION: YOU SHOULD CARFFULLY EKEAD THE FOLLOWING
TEFMS AND CONDITIONS OF THIS end user license AGREEMENT
BEFORE INSTALLING OR USING THE FPRODUCT AND
DOCUMENTATION TO WHICH THIS AGREEMENT EELATES. BY
ACCEPTING THIS AGREEMENT YOU ARE CONSENTING TO BE
BOUND BY THE TERMS AND CONDITIONS CONTAINED
HEREIN AND ACENOWLEDGING YOUR AUTHORITY TO DO 80 ON
BEHALF OF YOUR COMPANY (IF APFLICABLE). IF YOU DO NOT
AGFEE WITH THESE TERMS3 AND CONDITIONS, DO NOT PROCEED ~

(71 | aooapt the terms of the Licanse Agresment

@ 1do NOT accept the terms of the Licenss Agreament

4. After you have read, understood, and agreed to the terms of the End User License Agreement, choose |
accept the terms of the license agreement, and then click Next.

The Choose Install Folder panel opens.
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Chapter 4: Installing Corticon Servers and Web Console

E Progress Corticon Server 5.7.0.0 = ﬂ

Corticon Server Install and Work Directory

3) Progress’

Please choose install and work directory

Install Directory |C:\Program Files\Progress\Corticon 5.7

l Restore Default ” Choose... l

Work Directory | C:\Jsers'gsaintma‘ProgressiCorticonWork_5.7

’ Restore Default ” Choose... l

Cancel Previous

5. The default installation directories are shown. To specify preferred directories on each line, either enter the
explicit path, or click Choose to browse to each preferred directory.

Note: For Linux installations, the work directory path must not contain spaces.

6. If you see the upgrade panel instead, Corticon Server components are already installed. You can add
previously unselected components but you cannot change the install location or uninstall existing components.

E Progress Corticon Server 5.7.0.0 = ﬂ

Previous Version Details

:n PFOQFESS' A previous install of Corticon ServerWersion: 5.7.0.0is installed here:
CA_avk_install_dinhome .
Continue will upgrade this existing installation.

Previous

7. Click Next.

24 Progress Corticon: Installation Guide: Version 5.7



Running the Server and Web Console installer wizard

The Choose Server Components panel opens.

Progress Corticon Server 5.7.0.0

3) Progress’

Corticon Server for Java

- 10| x|

Choose Server Components

chosen and grayed out.

Choose the one or more components you want to install at this time. Any components already installed are

Note: The Linux installer does not enable a Corticon Server for .NET installation.

Click Next.

If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.

Progress Corticon Server 5.7.0.0

3) Progress’
HTTP Paort

HTTFS Port:

gress® Corticon® ShutDown Part

Cancel

=10 x|

Corticon Server Instance Port Numbers

8852
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9. If any of the preferred ports conflict with existing applications, you can change them at this time to an integer
value from 1024 to 49151. Be aware that the documentation references these ports as though the default
values, as shown, were accepted. Consult with your system administrator to identify alternate ports you
might use, or to reset the ports on the conflicting applications.

Enter your preferred port numbers, and then click Next.

The Pre-Installation Summary page opens.

10. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.

1. Click Install to continue.
The installation status window opens.
When done, the Install Complete panel opens.

Progress Corticon Server Service Pack 5.6.1.0 ;l_l&

Install Complete

ﬂ PFDQFESS Congratulations! Progress Corticon Server has been successfully
installed to:

CAProgram Files\Progress\Corticon 5.6

Progress® Corticon® Press "Done” to guit the installer.

Previous

12 Choose Done to complete the Corticon Server / Web Console installation and close the installer.

The installation and update of Corticon Servers and Web Console 5.7 is complete.

Note: Using an LDAP store for Web Console authentication - You can set up Corticon Web Console to
authenticate users using an LDAP server. See the topic "Using LDAP for Web Console authentication" in the

Web Console Guide.

Performing silent installations of Server components

An unattended (silent) install requires that you first run an installation in the installer wizard (Windows or Linux)
to capture the selected components and options, and then use the captured response file on targets on the
same platform to 'playback’ the responses into the installer without any user interaction.
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Performing command-line Linux installations of Server components

Silent installations or updates for Corticon Server Components on Windows:

1. Run the Corticon Server for Windows installer with your preferred locations and options to capture a response
file, using the syntax installer.exe -r filewhere installeris the preferred Server installer, and
fileis the response file you will reuse. For example:

PROGRESS CORTICON 5.7 SERVER WIN 64.exe -r C:\CorticonServer 57 WIN.responses

2. On other target Windows machines, access the Server 5.7 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f filewhere installeristhe
Server installer, and £i1e is your response file. For example:

PROGRESS CORTICON 5.7 SERVER WIN 64.exe -1 silent -f
C:\CorticonServer 57 WIN.responses

Silent installations or updates for Corticon Server Components on Linux:

1. Run the Corticon Server for Linux installer with your preferred locations and options to capture a response
file, using the syntax installer.bin -r filewhere installeris the preferred Server installer, and
fileis the response file you will reuse. For example:

PROGRESS CORTICON 5.7 SERVER LNX 64.bin -r
/usr/corticon/CorticonServer 57 LNX.responses

2. On other target Linux machines, access the Server 5.7 installer binary and the response file.

3. Run the installer using the syntax installer.bin -i silent -f file where installeristhe
Server installer, and 7i1e is your response file. For example:

PROGRESS CORTICON 5.7 SERVER LNX 64.bin -i silent -f
/usr/corticon/CorticonServer 57 LNX.responses

Performing command-line Linux installations of Server
components

A command-line install runs a Linux installation in a command shell as a text command with parameters.
To perform command-line installations for Corticon Server components:

1. On a supported 64-bit Linux platform, access the downloaded Linux installer binary file,
PROGRESS CORTICON 5.7 SERVER LNX 64.bin

2. In a shell, run the binary with the console option. For example:

# ./PROGRESS CORTICON 5.7 SERVER LNX 64.bin -i console

3. Follow the prompts to complete the installation via the command-line.

Note: For Linux installations, the work directory path must not contain spaces.
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Setting up and updating IS for .NET Server

The runtime server for Corticon Server for .NET is Microsoft Internet Information Services (11S), a distinct setup
into which you install the latest Corticon resources. This topic links to initial setup of 1S, adjustments to its
setup when upgrading, and the follow-up task to every upgrade or service pack update that copies the latest
resources to the IS location.

To setup IIS to support Corticon Server for .NET 5.7.x, access the appropriate Corticon Knowledgebase article
that describes the complete configuration of .NET Framework and IIS:

* Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7 for Corticon Server for .NET 5.x. These
instructions are also appropriate for Windows 10.

e Steps to set up IIS 8.0 and 8.5 on Windows Server 2012 R1 and R2 for Corticon Server for .NET 5.x These
instructions are also appropriate for Windows Server 2016.

Note:

Corticon on IIS needs to use Common HTTP Features. You can confirm or set these features in the Control
Panel > Programs and Features. Select Turn Windows feature on or off, and then expand to Internet
Information Services > World Wide Web Services. Turn on all the features in the IIS program feature group
Common HTTP Features

To upgrade or update Corticon Server for .NET into the IIS location:
1. Start Administrative Tool > lIS Manager. In the Actions panel, click Stop.
2. In [CORTICON HOME 5.7]\Server .NET\IIS,launch install.bat.

3. Accept or adjust the target location, and then press Enter. The 5.7 resources and the deployment descriptor
files are copied. The corresponding assets are copied to the IIS path, /Samples/Rules Projects.

4. In the IIS Manager, on the Actions panel, click Start.
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Registering your Corticon license

Progress Corticon customers must replace the evaluation license to enable the licensed features and time
limits.

When you obtain a license file, it applies to Studios as well as Servers. You must perform configuration tasks
to record it for each Corticon Studio, each Corticon Server, and each Deployment Console.

For details, see the following topics:

e Updating your Corticon Studio license

* Updating your Corticon Server license

Updating your Corticon Studio license

When you are provided a license for Corticon Studio, you receive a JAR file. Save the file on the target machine
or at a location that is network-accessible to the installation. The default license file for evaluation is embedded
within the installation and cannot be replaced directly. In this example, the license file that both Studio and
Server will use, CcLicense.jar, is placed at C:\1licenses.

To update a Studio license, do the following:
1. With Studio running, select the menu command Window > Preferences.
2. Expand the Progress Corticon group.

3. Inthe License File entry area, enter or browse to the location of the license JAR:
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Preferences l S | S

type filter text Progress Corticon - v v
- General
Ant

- Help

- Install/Update Override Properties File: = C:\preferences\my_brms.properties | | Browse...

- Java

- Model Validation
- Mylyn

General Progress Corticon Settings:

!

License File: C\licenses\Cclicense,jar Browse...
- Plug-in Development

License Information:

" Progress Customer Support Progress Corticon Studio
- Run/Debug Version: 5.7.0.0 -b1616
--Team Licensed to: Evaluation
- Viewruleflow Diagram EDC Enabled: Yes

Expires in 88 days.

| Restore Defaults.| | Apply |

{";?jl [ 0K l | Cancel |

e

4. Click Apply, and then click OK.
5. Restart Corticon Studio.

Updating your Corticon Server license

When you obtain a Server license file as a customer, you need to locate it at the default locations as well as
the runtime locations. Then, when you stop and restart Corticon Server again, your license file is referenced.

Updating the .NET server license

Copy your CcLicense. jar file, and then paste it to replace the existing file at:
* [CORTICON HOME]\Server .NET\samples\1lib\
* [CORTICON HOME]\Server .NET\webservice\lib\

* The IS location, typically: C: \inetpub\wwwroot\axis\1ib\

Updating the Java server license

Copy your CcLicense.jar file, and then paste it to replace the existing file at:
* [CORTICON HOME]\Server\lib\

* [CORTICON WORK DIR]\Server\pas\server\webapps\axis\WEB-INF\1lib

Note: When you download .ear and . war files for deployment onto other supported platforms and application
servers, they contain the evaluation CcLicense.jar. Once you are a Corticon customer, you are provided
a permanent version of this file. Inserting the CcLicense. jar file into the .ear or .war will replace the
evaluation file to redefine the license limitations.
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Updating your Corticon Server license

Note:

You can choose to locate the license by another JAR name at a preferred location, and then expressly identify
it to the server.

To custom configure Corticon Java Server's license location:
1. Navigate in the file system to the installation's [CORTICON HOME] \Server\bin subdirectory.
2. Double-click on testServerAxis.bat, then do the following:

a. Type 416 and then press Enter.

b. Enter (or copy/paste) the complete path to the location of the license JAR file, as in this example,
C:\licenses\myCorticon CcLicense.jar. The command echoes back Transaction
completed.

c. To confirm the setting, type 415, and then press Enter. The path is echoed back.

3. For the in-process instance, double-click on testServer.bat to perform the same 416 and 415 tasks
as in Step 2 above

Limits of the Server evaluation license

The license included in the default Corticon Server installation has pre-set limits on certain Corticon Server
and Decision Service parameters. These limits are:

* Number of Decision Services — Up to 20 Decision Services may be deployed at any given time. This
means the sum total of all Decision Services loaded via . cdd files, Web Console, or APIs cannot exceed
20.

* Number of Rules — All rules in all deployed Ruleflows (that is, all deployed Decision Services) must not
exceed 500. A rule generally consists of a single Condition/Action Column or a single Action row in Column
0. Filter expressions do not count because they only modify other rules.

The Corticon Server log can capture errors and exceptions caused by expired or “under-strength” licenses. These
log messages are detailed in the Using Corticon Server logs section of the Integration and Deployment Guide.

If you are Progress Corticon customer, you should have access to an unlimited license that will lift these
restrictions. If you are an evaluator, and discover that these limitations are preventing or inhibiting your evaluation,
contact your Progress Software representative to get a license with expanded capabilities.
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Uninstalling Corticon Products

Uninstalling Corticon Studio or Corticon Server results in removing a complete major.minor version of those
products, including any service packs or hotfixes applied. It is not possible then to uninstall just a service pack
or hotfix.

Uninstalling Corticon Studio
To remove a version of Corticon Studio, do the following:
1. Close Corticon Studio.

2. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Studio 5.7.x to launch its uninstaller.

Note: You could initiate the same task directly by navigatingto [CORTICON HOME]\Uninstall Progress
Corticon Studio 5.7, andthen running Uninstall Progress Corticon Studio 5.7.exe.

The installed files in the Studio's [CORTICON HOME] are removed. Files you created (including the complete
workspace) are NOT removed or replaced during this process.

If the Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.

Uninstalling Corticon Server

The Corticon Server components -- Corticon Server for Java, Corticon Server for .NET, and the Corticon Web
Console -- use common installation directories. As such, you cannot choose to uninstall just selected components.
Uninstallation will remove all installed server components.

To uninstall Corticon Server on Windows:
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1. Stop Corticon Server.
2. Backup any files you want to retain.

3. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Server 5.7.x to launch its uninstaller.

Note: You could initiate the same task directly by navigatingto [CORTICON HOME]\Uninstall Progress
Corticon Studio 5.7, andthenrunning Uninstall Progress Corticon Server 5.7.exe.

To uninstall Corticon Server on Linux:
1. Stop Corticon Server.
2. Backup any files you want to retain.

3. Inacommand shell, navigate to [CORTICON HOME]\Uninstall Progress Corticon Studio 5.7,
and thenrun Uninstall Progress Corticon Server 5.7.bin.

The installed files in the Server's [CORTICON HOME] are removed. Note that files you created are NOT removed
or replaced during this process. No server files in the [CORTICON WORK DIR] are removed.
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Corticon 5.7 Online Tutorials and

Documentation

TUTORIALS: Learn about Corticon from online lessons at the Corticon Learning Center.

DOCUMENTATION: About this release

What's New in Corticon PDF HTML

Describes the enhancements and changes to the product since its
last point release.

Corticon Installation Guide PDF HTML

Step-by-step procedures for installing Corticon Studio and Servers
in this release on Windows and Linux platforms.

DEVELOPMENT DOCUMENTATION: Define and Model Business Rules

Rule Modeling Guide PDF HTML

Introduces how business rules are modeled in Corticon Studio
including the creation of Vocabularies, Rulesheets, Ruleflows, and
Ruletests. This is the starting point for new rule modelers.

Quick Reference Guide PDF HTML

Reference guide to the Corticon Studio user interface, including
descriptions of all menu options, buttons, and actions.

Rule Language Guide PDF HTML

Reference information for all operators available in the Corticon Studio
Vocabulary.
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Appendix A: Corticon 5.7 Online Tutorials and Documentation

Guide to Creating Extensions PDF
HTML

Detailed technical information about the Corticon extension framework
for extended operators and service callouts.

Javadoc for Extensions APl HTML

Complete Java API reference for Corticon Extensions.

DEPLOYMENT DOCUMENTATION: Run Decision Services on Servers

Integration and Deployment Guide PDF
HTML

Provides details on deploying and managing Corticon decision
services. Start here to learn about the options for deploying Corticon,
the best practices for managing your deployment, and the APIs for
integrating Corticon with clients executing rules.

Data Integration Guide PDF HTML

Provides details on how to integrate Corticon with external data
sources and how to use Corticon for batch rule processing. Includes
details on Corticon EDC and ADC features for accessing data from
decision services.

Web Console Guide PDF HTML

Presents the Corticon Web Console which can be used to manage
your Corticon deployment. This GUI interface simplifies the
management and monitoring of Corticon servers and decision
services.

Deploying Web Services with Java PDF
HTML

Provides details on deploying Corticon as a REST or SOAP web
service on Java application servers.

Deploying Web Services with .NET
PDF HTML

Provides details on deploying Corticon as a REST or SOAP web
service on Microsoft IIS.

Javadoc for Corticon Server APl HTML

Complete Java API reference for Corticon Server.
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